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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page humber. The numbering convention for the DS number is
“DSXXXXXA”, where “XXXXX” is the document humber and “A” is the revision level of the
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help.
Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MCP6HO04 Evaluation Board. ltems discussed in this chapter include:

» Document Layout

» Conventions Used in this Guide

* Recommended Reading

» The Microchip Web Site

» Customer Support

+ Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP6H04 Evaluation Board. The manual
layout is as follows:

+ Chapter 1. “Product Overview” — Important information about the MCP6H04
Evaluation Board.

» Chapter 2. “Installation and Operation” — Includes instructions on how to set up
and operate the MCP6HO04 Evaluation Board.

+ Appendix A. “Schematic and Layouts” — Shows the schematic and layout
diagrams for the MCP6H04 Evaluation Board.

« Appendix B. “Bill of Materials” — Lists the parts used to build the MCP6HO04
Evaluation Board.

© 2011 Microchip Technology Inc. DS52005A-page 5
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

| Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User’s Guide

Emphasized text

...Is the only compiler...

dialog

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”

Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, Ris the radix and nis a
digit.

4'b0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl8\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants OxXFF, ‘A’

Italic Courier New

A variable argument

file.o, where file can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file

[options]

Curly brackets and pipe
character: { | }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {O|l}

Ellipses...

Replaces repeated text

var_name [,
var_name...]

Represents code supplied by
user

void main (void)

{
}

DS52005A-page 6

© 2011 Microchip Technology Inc.




Preface

RECOMMENDED READING

This user's guide describes how to use the MCP6HO04 Evaluation Board. Other useful
documents are listed below. The following Microchip document is available and
recommended as a supplemental reference resource.

« MCP6HO01/2/4 - “1.2 MHz, 16V Op Amps” (DS22243)

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

* Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

+ Distributor or Representative

* Local Sales Office

+ Field Application Engineer (FAE)
+ Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical supportis available through the web site at: http://www.microchip.com/support.

DOCUMENT REVISION HISTORY
Revision A (October 2011)

« Initial Release of this Document.

© 2011 Microchip Technology Inc. DS52005A-page 7
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MCP6H04 EVALUATION BOARD
MICROCHIP USER’S GUIDE

Chapter 1. Product Overview

1.1 INTRODUCTION

The MCP6HO04 Evaluation Board is described as follows:
» Assembly #:114-00375-R2

* Order#: MCP6HO4EV

» Name: MCP6H04 Evaluation Board

1.2 BOARD DESCRIPTION

The MCP6HO04 Evaluation Board is intended to support an instrumentation amplifier
and show the capability of the MCP6HO04 operational amplifier. The board has the
following features:
+ All amplifier resistors and capacitors are socketed
 Supports MCP6H04 Microchip quad op amp

- SOIC-14 package
» Test points for connection to lab equipment
« Single supply configuration
Figure 1-1 shows the block diagram of the MCP6HO04 Evaluation Board. Lab equipment
can be attached (via test points) to measure the amplifier response.

Mid-Supply re
and
Test points
A4
Power supply Amplifier Circuit Output signals
and (Op-amp, resistors, and
Test Points Capacitors) Test points
A
Signal Inputs
and
Test Points
FIGURE 1-1: MCP6HO04 Evaluation Board - Block Diagram.

© 2011 Microchip Technology Inc. DS52005A-page 9
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1.3 WHAT THE MCP6H04 EVALUATION BOARD KIT INCLUDES

* MCP6HO04 Evaluation Board, 102-00375
* Important Information Sheet

» Accessories Bag — contains loose parts for populating sockets on board, such as
resistors and capacitors

FIGURE 1-2: MCP6H04 Evaluation Board View.

DS52005A-page 10 © 2011 Microchip Technology Inc.
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Chapter 2. Installation and Operation

2.1  INTRODUCTION
This chapter describes how to set up the MCP6HO04 Evaluation Board. Topics
discussed in this chapter include:

* Required Tools
+ MCP6HO04 Evaluation Board Set-Up
+ MCP6HO04 Evaluation Board Operation

2.2 REQUIRED TOOLS

The following tools are required for testing the functionality of the board:
» Lab power supply

» Lab dual signal source (e.g., dual function generator)

» Lab measurement equipment (e.g., oscilloscope)

2.3 MCP6H04 EVALUATION BOARD SET-UP

The MCP6HO04 Evaluation Board uses a quad op amp in difference amplifier
configuration with input buffers and voltage reference. Figure 2-1 shows the circuit
diagram of the board.

VDD VF{EF

FIGURE 2-1: MCP6HO04 Evaluation Board Circuit Diagram.

© 2011 Microchip Technology Inc. DS52005A-page 11
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The power supply voltage needs to be in the allowed range for the op amp. The
MCP6H04 device supports a maximum of 16V power supply. The power supply is
protected by a Zener diode with a nominal voltage of 16V and bypassed by a 1 pF
capacitor (see Figure 2-3).

The mid-supply reference voltage consists of a voltage divider and a buffer amplifier
(see Figure 2-4).
The resistors that are part of the ampilifier are placed in pin sockets, which are labeled.

All component labels on board are consistent with those on the schematic. The op amp
on board is a 14-lead SOIC package, and is bypassed by a 0.1 uF capacitor.

The test points for the power supply, ground, input signals, output signals, and voltage
reference allow lab equipment to be connected to the board. The MCP6H04 Evaluation
Board top view is shown in Figure 2-2.

pipog |DA] yYOHI9HIN
diHD0OHE2IW @

4

Vout1 GND Vin— Vin+ GND Vout2
102-00375

FIGURE 2-2: MCP6HO04 Evaluation Board Top View.

DS52005A-page 12

© 2011 Microchip Technology Inc.



Installation and Operation

2.3.1 Top Level Amplifier Circuit Diagram

2.3.1.1  POWER SUPPLY BLOCK

The power supply is protected by a Zener diode and bypassed by a capacitor.
Figure 2-3 shows the circuit diagram for the power supply (C> = 1 pF). Dpq is a Zener
diode with a nominal voltage of 16V.

FIGURE 2-3: Circuit Diagram for Power Supply.
2.3.1.2 MID-SUPPLY REFERENCE BLOCK

The mid-supply reference consists of a voltage divider and a buffer amplifier. Figure 2-4
shows the circuit diagram for the mid-supply reference (R3 = R4 = 100K, C3 =0.1 uF).

Rs

cﬁ . *

FIGURE 2-4: Mid-Supply Reference Block.

2.3.1.3 OUTPUT LOAD BLOCK

The output load consists of a capacitor and a resistor. Figure 2-5 shows the circuit
diagram of the output load (R, = 10K, C, = 56 pF).

Ve VOUT

RL G

FIGURE 2-5: Output Load Block.

© 2011 Microchip Technology Inc. DS52005A-page 13
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2.3.1.4 INPUT STAGE

The input stage consists of two resistors and three capacitors. All three capacitors are
forming a noise filter. Figure 2-6 shows the circuit diagram of the input stage
(C5=Cg=10nF, C4 = 100 nF and R5 =Rg = 1K).

Rs
Vin(-) Va

V|N(+)

FIGURE 2-6: Input Stage Block.

2.3.1.5 INPUT BUFFER BLOCK

The input buffer block consists of two op amps in buffer configuration with outputs tied
together through one resistor. Figure 2-7 shows the circuit diagram of the input buffer
block (RF = RF* = 50K, RG = 1K)

Vourz

FIGURE 2-7: Input Buffer Block.

DS52005A-page 14
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2.3.1.6  DIFFERENCE AMPLIFIER

This circuit amplifies the difference between two voltages, while rejecting the Common
mode input voltage. Output voltage can be shifted by a reference voltage for single
supply operation.

Fill the sockets with the recommended resistors and capacitors (see the circuit diagram
shown in Figure 2-8).

VRer

FIGURE 2-8: Difference Amplifier Block.
The jumper positions have the following effect:

» JP1 connected to ground: the output voltage will be centered on 0V.
+ JP1 connected to Vggg: the output voltage will be centered on 8V.

24 MCP6H04 EVALUATION BOARD OPERATION

This section covers the following topics:
+ Building the Amplifier
+ Testing the Amplifier

2.4.1 Building the Amplifier

The accessory bag that comes with this kit facilitates the evaluation of the amplifier
described below.

The amplifier characteristics are:

* Instrumentation amplifier (Single supply operation)
» Power supply voltage = 16V

* Desired Gain = 101 V/V

» Load Capacitance = 56 pF

© 2011 Microchip Technology Inc. DS52005A-page 15
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VlN- 1K V1
— R5 \Y EF R C1 16V
Rio MCP6H04 1 61 1100k] 100n
Cs 10k
ViNG)
10n S
Co==100n MCP6
10n
V|N+ R11 C4 <
PR MCP6H04
K T
Vin(+)
Oré
16V
FIGURE 2-9: Schematic of the Instrumentation Amplifier Designed for Simulation.
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Figure 2-10 shows the same circuit redrawn to emphasize the instrumentation

amplifier.
~  Voun
Q
Vin(-)
Vour
Ra
RL CL
Vin(+)
Voltage
Vourz reference| ..
Power
Supply o vy
FIGURE 2-10: Instrumentation Amplifier Diagram Block.

Each of the components in Figure 2-10 that need to be inserted in a socket on the
MCP6HO04 Evaluation Board is listed in Table 2-1 and Table 2-2. The op amp is
soldered on the PCB.

TABLE 2-1:  AMPLIFIER COMPONENTS LIST

PCB Labels Component Value

Rk 50K
Rg* 50K
Rg 1K

R4 10K
R¢* 10K
Ro 10K
Ro* 10K
R. 10K

CL 56 pF

TABLE 2-2:  JUMPER POSITIONS

Jumper Position
JP1 Vpp/2
GND

© 2011 Microchip Technology Inc. DS52005A-page 17
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The fully assembled MCP6HO04 Evaluation Board top view is shown in Figure 2-11.

R
L
C3
g e r
R3 R4
R1% -~ v
.4|'-||' ‘
Ul=..

JLUNJYSU|

(©)
2
N

)|

0

0

I

T

sy duiy

RS 04'

NEE S OEE

Vout1 GND Vin— Vin+ GND Vout2
102-80375

FIGURE 2-11: MCP6H04 Evaluation Board Top View.

24.2 Testing the Amplifier
2421 CHECKING THE TEST POINTS

The test points for the power supply, ground, input signals and output signals allow lab
equipment to be connected to the board. Figure 2-12 shows the test points to check.

VDD Ground VOUT
Test Point Test Point Test Point

VDD  GND Vout

E

Voltage
Reference
Test Point

Ground
Test Point

Vour1 ' LG4,
Test Point -]u ¥ (25- ¥ C6 VouTe
! Test point
Vout1 SND Vin— Vin+ GND Ouh
102-B@575
Ground Negative Input Positive Input round
Test Point  Test Point Test point Test Point
FIGURE 2-12: Check-in Test Points.

DS52005A-page 18 © 2011 Microchip Technology Inc.
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2422 BOARD VALIDATION

All resistors in sockets have 0.1% tolerance and all soldered resistors have 1%
tolerance. The capacitors have 20% tolerance.

2.4.2.2.1 Sine Wave Response

Settings in bench measurement:

+ Set V| for Source(-) at 10 mV, 10 Hz, 0° phase and a Common mode voltage
of 4V

+ Set V| for Source(+) at 10 mV,10 Hz,180° phase and a Common mode voltage
of 4V

* VRer = Vpp/2

® VDD = 16V

» The output signal is centered on 8V
+ The amplifier’s Gain is 101 V/V

Figure 2-13 shows the result of this measurement.

PreVu

VouTi
VREF

ouT2
VouT

15 Jun 2011]

|o 500my B @ S00mv B | 500kS/s 1 ”
J=+*0.00000s 100k points  —3.97 V J[13:16:25

FIGURE 2-13: Sine Wave Response.
Simulation settings:

+ Set V) for Source(-) at 10 mV, 10 Hz, 0° phase and Common mode voltage 4V

+ Set V) for Source(+) at 10 mV,10 Hz,180° phase and Common mode voltage 4V
* VRer = Vpp/2

® VDD=16V

» The output signal is centered on 8V

» The amplifier’s Gain is 101 V/V

Figure 2-14 shows the results.

© 2011 Microchip Technology Inc. DS52005A-page 19
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10.50
10.00
9.500
9.000
8.500
8.000
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7.500
7.000
6.500
6.000

5.500
0.000m 50.00m 100.0m 150.0m 200.0m 250.0m 300.0m
Time (s)

350.0m 400.0m 450.0m

4.010
4.008
4.005

4.003

v)

4.000
3.998
3.995
3.993

3.990
0.000m 50.00m 100.0m 150.0m 200.0m 250.0m 300.0m 350.0m 400.0m 450.0m
Time (s)

5.250
5.000
4.750
4500
4.250
4.000 S
3750 -
3.500
3.250
3.000

2.750
0.000m 50.00m 100.0m 150.0m 200.0m 250.0m 300.0m 350.0m 400.0m 450.0m

)

Time (s)

out
VREF

500.0m

VIN+
VIN-

500.0m

VOuT2
VOuT1

$500.0m

FIGURE 2-14: Simulation of the Sine Wave Response.

24222 Square Wave Response
Settings in bench measurement:

+ Set V) for Source(-) at 50 mV,10 Hz, 0° phase and Common mode voltage 4V
+ Set V) for Source(+) at 50 mV,10 Hz, 180° phase and Common mode voltage 4V

* VRer = Vpp/2

® VDD=16V

» The output signal is centered on 8V
» The amplifier’s Gain is 101V/V

Figure 2-15 shows the result of this measurement.

|0 1.00V ~&% @B 1.00V A& "‘||'20.0ms 500kS/s
J\m~¥0.00000s

100K points  —4.00V |

& - "'|"'151un 2011]

l13:19:01 |

FIGURE 2-15: Square Wave Response.
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Simulation settings:

+ Set V| for Source(-) at 50 mV,10 Hz, 0° phase and common mode voltage 4V
Set V| for Source(+) at 50 mV,10 Hz, 180° phase and common mode voltage 4V

+ The amplifier’s Gain is 101V/V
Figure 2-16 shows the result of this simulation.

VRer = Vpp/2

Vpp=16V
The output signal is centered on 8V

()

v)

9.250
9.000
8.750
8.500
8.250
8.000

ouT

VREF

7.750
7.500
7.250
7.000

6.750
0.000m

4.005

100.0m

200.0m

Time (s)

300.0m

400.0m

4.004
4.003
4.002
4.001
4.000
3.999
3.998
3.997
3.996

3.995
0.000m

4.005
4.004
4.003
4.002
4.001
4.000
3.999
3.998
3.997
3.996

100.0m

200.0m

500.0m

VIN+

Time (s)

300.0m

400.0m

500.0m

3.995
0.000m

4.750

4.500

100.0m

200.0m

Time (s)

300.0m

400.0m

VIN-

500.0m

VOUT1
vouT2

4.250

4.000

3.750

3.500

3.250
0.000m

100.0m

200.0m

Time (s)

300.0m

400.0m

500.0m

FIGURE 2-16:

Simulation of the Square Wave Response.
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2.4.2.2.3 DC Response

Settings in bench measurement:

+ Set V) for Source(-) at 80 mV DC signal
+ Set V|\ for Source(+) at 30 mV DC signal
* VRer = Vpp/2

* Vpp=16V

Figure 2-17 shows the result of this measurement.

o e e e e N e o

|"o 10.0my 48y & 20.0mvie ” 40.0ns
L +¥0.00000 s

FIGURE 2-17: DC Response.
Simulation settings:

+ Set V) for Source(-) at 80 mV DC signal
+ Set V| for Source(+) at 30 mV DC signal
* VRer = Vpp/2

* Vpp=16V

2.30G5/8
1M points

Figure 2-18 shows the result of this measurement.

e e |V O T 1

IRV ouUT2

VouT

REF

”lOJI.II‘I 2011)
*10 OmV | 13:38:55
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8125 .
VREF
8100
8075
B 8.050
8025
8000
7.975
0.000u 0.500u 1.000u 1.500u 2.000u 2.500u 3.000u 3.500u 4.000u 4.500u 5.000u
Time (s)
150.0m ViN.
VIN-
vouT1
125.0m VOuT2
100.0m
B 75.00m
50.00m
25.00m
0.000m
0.000u 0.500u 1.000u 1.500u 2.000u 2.500u 3.000u 3.500u 4.000u 4.500u 5.000u
Time (s)

FIGURE 2-18: Simulation of the DC Response.
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Appendix A. Schematic and Layouts

A.1  INTRODUCTION
This appendix contains the following schematics and layouts of the MCP6HO04
Evaluation Board:
+ Board — Schematic
» Board — Silk and Solder Mask
» Board — Top Metal Layer
» Board — Bottom Metal Layer (bottom View)
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